INTRODUCTION

Microchip's Mindi™ Simulator Tool aids in the design and analysis of various analog circuits used in Power Management and Linear applications.

This interactive simulator tool enables designers to quickly generate circuit diagrams, simulate circuits and specify passive components for a variety of power, battery-charger and linear applications. Circuits developed using the Mindi™ simulation tool can be downloaded to a personal computer (PC) or workstation and can often be ported directly into system diagrams.

ACCESSING MINDI ON MICROCHIP’S WEB SITE

The Mindi simulation tool can be accessed on Microchip’s home web page at www.microchip.com under “Online Simulation Tools” or by going directly to the Mindi home page at http://www.microchip.com/mindi.
The Mindi home page is shown in Figure 2. To enter the Mindi Simulator Tool, select the “Click Here” button in the upper left hand corner of the window.

**FIGURE 2:** Bring up the Mindi Simulator Tool by selecting “Click Here” on the Mindi Home Page.

The first time Mindi is accessed, the user will be prompted to provide some basic registration information.

Once registered, an account is created on the Host Server and users will be able to generate and analyze designs on the Mindi Design Tool web page. Custom designs can also be saved to their PC, where they can be accessed for future reference.

**Note:** If a “pop-up blocker” is enabled on the user’s browser, then there may be a problem with the registration process. Please be sure to disable this feature when registering on Mindi. On Internet Explorer, this may be done by selecting the Pop-Up Blocker window under the Tools pull-down menu.

Once the user logs into Mindi, the “Application Circuit” menu is displayed indicating the Circuits that are available for design and simulation, as shown in Figure 3.

**FIGURE 3:** Select the Application Circuit on the “Application Circuit” page
CIRCUIT SIMULATION STEPS

The Mindi Simulator Tool is divided into four sections or “circuit simulation steps”, making it easy to choose the right circuit for your application. Once an Application Circuit is selected, the Mindi Simulator Tool will guide the user through choosing a circuit configuration, generating a complete circuit solution and performing simulations to analyze the circuit behavior.

The four circuit simulation steps are represented by four page tabs at the top of the window display after the initial Application Circuit is selected. They are:

1. Application Circuit.
2. Input Requirements.
3. Analyze.

Figure 4 illustrates the four tabs in the Mindi Simulator Tool.

FIGURE 4: Four tabs step the user through a circuit design.

Application Circuit

The Application Circuit tab brings up the “Application Circuit” page, shown in Figure 3. The Mindi simulator tool defaults to this page after the user logs on to the tool. On this page, one of the major Application Circuits can be selected. For Power Management, there are two Application Circuits, “Battery Chargers” or “DC-to-DC Converters”.

After the user has selected one of these Application Circuits, Mindi will display the next tab, Input Requirements.
Input Requirements

The Input Requirements tab brings up the Circuit Configuration shown in Figure 5 and Figure 6. The user can select the appropriate circuit configuration and specify operating parameters on this page.

**FIGURE 5:** Select the Circuit Configuration on the “Input Requirements” page

In the example shown in Figure 5, the general application, “Integrated DC/DC 1A Regulator” has been selected. The list of Configuration Circuits can be viewed in the pull-down window on the “Input Requirements” tab.

When a Circuit Configuration is selected, a description of the circuit is displayed, along with circuit input requirements and a block diagram of the circuit solution, as shown in Figure 6.

**FIGURE 6:** All Circuit Configurations provide a Circuit Description, Block Diagram and user-defined Input Requirements.
The user may then enter operating parameters in the “Input Requirements” section of the window. Figure 7 illustrates a user-defined set of operating parameters for the Integrated DC/DC 1A Regulator circuit configuration.

**FIGURE 7:** User-defined Input Requirements for the Integrated DC/DC 1A Regulator Circuit Configuration.

Note that the operating limits are summarized in the Circuit Description shown in Figure 6. In this case, the Integrated DC/DC 1A Regulator circuit configuration states that \( V_{IN} = 2.5V \) to 5.5V and \( I_{OUT} < 1A \). If values exceeding these limits are entered into the Input Requirements, a warning pop-up window will appear with the parameter limit (Figure 8). The window may not appear until the “Analyze” button is selected in the lower right hand corner of the window.

**FIGURE 8:** A warning pop-up indicates that an invalid input has been entered.

After the Input Requirements are properly entered, select the Analyze button to implement a circuit solution that will achieve the specified requirements. This resulting circuit is shown as a schematic in the “Analyze” window.
Analyze

The **Analyze** tab implements a circuit solution that will achieve the specified input requirements. This is shown as a schematic on the “Analyze” page. Circuit simulations can also be performed on this page.

![Integrated DC/DC 1A Regulator Design Result](image)

**FIGURE 9:** Integrated DC/DC 1A Regulator Design Result.

Note that the schematic can be printed or downloaded using the “Print Schematic” and “Download Mindi Schematic” select buttons near the top of the window. The user can also download the Mindi Simulator tool to their PC by selecting the “Download Mindi” button. This allows the user to make modifications that include adding or deleting components or connections to the circuit and conduct new simulations and design analysis on their PC instead of using the interactive tool on Microchip’s web site. Adding or deleting components or connections can not be performed on the interactive web site tool. This is only allowed when analysis is executed on a local PC.

Three simulations can also be run to ensure that the circuit is stable and will operate as expected. The “Select Simulation” pull-down menu allows the user to choose from the list shown in Figure 10.

![Simulation Pull-down Menu](image)

**FIGURE 10:** Simulation Pull-down Menu.

---

© 2007 Microchip Technology Inc.
TRANSIENT ANALYSIS

The Transient Analysis simulation will analyze the circuit response to an applied step to the load current.

Once this simulation is selected, the user will be able to define the characteristics of the load step current by double-clicking on the LOAD symbol in the schematic, as shown in Figure 11.

FIGURE 11: Select the Current Load symbol to modify the Load Step Current.

The user can then define the Load Step characteristics in the Load Step pop-up window, as shown in Figure 12.

FIGURE 12: Current Load Step Pop-up Window.

The length of the simulation can be specified by selecting the "Configure Transient Analysis" button. Figure 13 shows the configuration pop-up window for a Transient Analysis simulation. This pop-up window allows the user to specify the length of time that the Transient Analysis simulation will run. Note that the actual time it takes Mindi to complete the simulation is affected by the length of time specified in this window.

FIGURE 13: Configure Simulation pop-up window for Transient Analysis simulation.
Once the simulation time has been set, then the “Run Transient Analysis” button can be selected. While the simulation is running, the “Run Transient Analysis” button will be grayed out, with the message “Running Transient Analysis” displayed, as indicated in Figure 14. The button returns to its normal state when the simulation is complete.

**FIGURE 14:** The “Run Transient Analysis” message is displayed while the simulator is running.

The signal waveform can then be displayed by selecting the “View Waveforms” pull-down menu. An example of the waveform analysis is shown in Figure 15. This waveform shows the transient response of the regulated output voltage (blue waveform) when the current load (purple waveform) is stepped from 0 Amps to 0.5 Amps with a rise time of 100 usec. Many other signal waveforms are also available for viewing and can enabled or disabled in the waveform viewer.

In more complicated circuits, the waveforms are group into four categories (output, switching, input, and signal). By looking at the probe’s name, one can easily tell which waveform grouping the probe is located.

**FIGURE 15:** Waveform Viewer showing Current Load Step and Output Voltage Response.
STEADY STATE ANALYSIS

The Steady State Analysis can be selected in the Simulation pull-down menu shown in Figure 10. This analysis will generate circuit waveforms under steady state conditions. The user can use this analysis to understand what is happening at various points in the circuit while modifying Input Voltage and Load Current.

In Figure 16, $V_{IN}$ and $I_{LOAD}$ have been modified to 4.5V and 1A, respectively. The waveform shown in Figure 17 illustrates the voltage at the LX pin of the device (LX, red waveform), the current coming out of the inductor (IL1, purple waveform) and the regulated output voltage ($V_{OUT}$, bold red waveform).

**FIGURE 16:** Modifying $V_{IN}$ and $I_{LOAD}$ for Steady State analysis.

**FIGURE 17:** Waveform Viewer showing Voltage output ($V_{OUT}$), LX output (LX) and current out of the inductor (IL1) during Steady State Analysis.
AC ANALYSIS

The AC Analysis can be selected in the Simulation pull-down menu shown in Figure 10. This analysis will generate a Bode plot showing the small signal response of the system. The small signal response is generated by injecting a small signal stimulus into the feedback loop of the DC-DC converter device. The user can use this analysis to understand system DC gain, bandwidth, and overall stability.

When AC Analysis is selected, an AC Voltage Source and Bode Analyzer symbol will appear in the schematic, as shown in Figure 18. This indicates where the AC signal is injected in the feedback loop.

**FIGURE 18:** AC Voltage Source and Bode Analyzer shown on schematic during AC Analysis.

The length of the simulation can be specified by selecting the “Configure AC Analysis” button. Figure 20 shows the configuration pop-up window for an AC analysis simulation. This pop-up window allows the user to specify the frequency range that the Analysis will sweep through.

**FIGURE 19:** Configure AC Analysis Pop-up Window.
The AC Analysis is performed by selecting the “Run AC Analysis” button. After the simulation is complete, the resulting Bode plot of phase and gain is illustrated in the waveform viewer.

**FIGURE 20:** Waveform Viewer showing Bode Plot of Phase and Gain during AC Analysis.
Bill of Materials (BOM)

The Bill of Materials tab displays a list of components used in the circuit solution. The BOM compliments the schematic shown on the Analyze tab. The BOM can be saved to the user’s PC by selecting the “Download Excel BOM” button, as shown in Figure 21.

![Bill of Materials Tab](image)

**FIGURE 21:** Bill of Materials Tab.

There are also two other buttons on this page. The “Order Device” button will link the user to the Microchip product web page of the device used to implement the simulator design. Among other things, the user can order a device sample or download the data sheet, related app notes, etc., on this web page. The “Order Eval Board” button will link the user to the Microchip eval board web page of a generic evaluation board solution for the simulated circuit. This board represents a circuit using default component values and can serve as a platform for evaluating the circuit on the bench.

CONCLUSION

The Mindi Simulator Tool allows system engineers to quickly design and evaluate power management and linear circuits, saving time with circuit development and selecting the right components. In this application note, an overview of the Power Management circuits available for simulation was provided and the key simulation functions were discussed. The user was then stepped through a circuit simulation example. This should allow system engineers to quickly come up to speed with the Mindi Simulator Tool and benefit from the features that the tool provides.
Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights.

Trademarks

The Microchip name and logo, the Microchip logo, Accuron, dsPIC, KEELoO, KEELoO logo, microID, MPLAB, PIC, PICmicro, PICSTART, PRO MATE, PowerSmart, rPIC, and SmartShunt are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AmpLab, FilterLab, Linear Active Thermistor, Migratable Memory, MXDEV, MXLAB, PS logo, SEEVAL, SmartSensor and The Embedded Control Solutions Company are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, CodeGuard, dsPICDEM, dsPICDEM.net, dsPICworks, ECAN, ECONOMONITOR, FanSense, FlexROM, fuzzyLAB, In-Circuit Serial Programming, ICSP, ICEPIC, Mindi, MiWi, MPASM, MPLAB Certified logo, MPLIB, MPLINK, PICkit, PICDEM, PICDEM.net, PICLAB, PICtail, PowerCal, PowerInfo, PowerMate, PowerTool, REAL ICE, rLAB, rPICDEM, Select Mode, Smart Serial, SmartTel, Total Endurance, UNI/O, WiperLock and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

All other trademarks mentioned herein are property of their respective companies.

© 2007, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

Printed on recycled paper.

Microchip received ISO/TS-16949:2002 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona, Gresham, Oregon and Mountain View, California. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KEELoO® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.